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Introduction 
NorthClark's Bill of Material and Parts Master Maintenance are designed to improve communication 
between Engineers, Sales Order Entry and the Manufacturing (MRP) process, and streamline the process 
of obtaining and/or maintaining the documented structure of engineered assemblies.  The Bill of 
Materials and Parts Master Maintenance product is a Windows based desktop application used to view, 
create, and modify Bills of Material, Engineering Change Orders, and Parts Master records in your 
Manfact system.   

The Bill of Material (BOM) and Parts Master Maintenance application allows the user to: 

� Use a flexible spreadsheet format to easily add and delete items, or change the structure of a 
multi-level Bill of Material. 

� Import Bill of Material structures and Parts Master details from an Excel spreadsheet or a tab-
delineated text file providing integration with virtually any CAD application. 

� Update the Manfact Bill of Material (BOM), Engineering Bill of Material (ENGBOM), and 
Work Order Bill of Material (WOBOM) files. 

� Customize printed output with the use of flexible reporting options. 

� Export Bill of Material to Microsoft Excel. 

� Create or update Item Master (PARTS) records.  

� Save partially updated or incomplete Bills of Material in a local Microsoft Access database, 
where they may be retrieved and posted to Manfact at a later time. 
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Bill of Material Setup Module  

The Bill of Material Setup Module (NCC_BomSetup) is used to select options and enter information to 
support the Bill of Material Maintenance and Parts Master Update Application.  Information includes: 

� Import / Export Maps for interfacing with Microsoft Excel  

� Locations of Drawing Files on the network 

� Custom Field Parameters 

o Case requirements for Part Numbers 

o Work Order release update options 

o Batch Instructions for WO07 execution 

 
Important Note:  The information updated by this procedure is stored in the ELF.TABLE file in the 
MRPISYS account.  Therefore, this information is applicable to all Manfact data accounts.  The 
parameters you enter here will apply to your live accounts as well as any test environments.  

Environment 

BOM Setup is designed in a similar manner to a Microsoft Windows “Properties” or “Options” screen.   
OK and Cancel Buttons appear at the bottom of each Display.  Clicking OK will save any changes you 
have made.  Clicking Cancel will exit without saving. 

The screen is composed of the following four tabs: 

� The Import / Export Maps Display contains mapping information for interfacing with Microsoft 
Excel. 

� The Drawing Locations Display designates drive, path, and folder names for design drawings per 
warehouse. 

� The Custom Fields Display is used for setting parameters for any custom fields added. 

� The Miscellaneous Display sets user options for Case, WO Release, and WO07 execution. 

Import/Export Maps Display 

To initialize or edit Mapping Information for use with Microsoft Excel or tab-delimited text files select 
an existing Map Description from the drop-down list in the Map Description field or click the New Map 
Button to create a new map. 
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The system displays a list of available fields in the first column of the mapping table.  These values may 
not be manually entered or changed.  Note:  If you have defined custom data using the Custom Fields 
Display, they will be displayed here and are available for mapping. 

Enter mapping information corresponding to the desired Spreadsheets.  In the example below, the 
Assembly Number appears in the first column on Row 4 of the spreadsheet.  The column indicator may 
be entered as either a letter (A in this example) or a number (1 in this example), and the system will fill 
in the corresponding letter or number automatically.   

If you wish to consolidate rows when the parts are repeated, place a check in the box Consolidate Rows 
When Part Number Repeated. 

If you wish to assume that the first part on the list is the assembly number, place a check in the box 
Assume First Part on List is the Assembly Number. 

If you wish to read the Manufacturer Names from the spreadsheet being imported and convert them to 
valid MANFR codes, place a check in the box Attempt to Translate Manufacturer Name.  The 
Manufacturer Name field in the cross-reference file supports wild-carding. 

 

Click the New Map Button to create mapping instructions from scratch.  When creating a new map, you 
must specify the File Type (Excel or Tab Delimited) and the number of Header Rows used in the Import 
File.  Note:  These are default values that will be displayed by the Bill of Material application, and may 
be changed by the user when importing a specific file. 

Click the Copy Map Button if your new map will be similar to an existing map.  Select a Map you wish 
to copy from the drop-down list.  Enter the name you wish to use for the new map in the dialogue box 
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that is displayed.  The copy feature will NOT copy the original rows assigned to the assembly 
information.  This will need to be entered for the new map.  Click the OK button to create the new Map. 

The Delete Map Button will entirely remove the selected mapping information. 

Click the OK Button to save changes. 

Drawing Locations Display 

During Bill of Material Maintenance, the user may select a part number and choose the Display 
Drawing option from the Tools Menu.  The system will search for a file or folder with the same name 
as the part number.  If the drawing is found, it will be displayed with the user’s preferred image viewing 
program. 

Use this display to instruct the system where on the network to begin searching for drawing files.  
Separate pathnames are defined for each warehouse. 

� Use the drop-down list to select a warehouse. 

� Click the Browse Button to locate the folders on your network or local hard drive containing 
Design Drawings or manually enter the pathname. 

� Click the OK Button to save changes. 
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Custom Fields Display 

The Custom Fields tab is used to add custom fields to the Bill of Material Maintenance and Parts Master 
Update Application. 

Warning! 

The entries you make in this screen identify the field locations where custom data will be 
stored in your Manfact system.  Incorrect entries could produce unpredictable results and 

have the potential for irreparable damage to the data in your Manfact system.  

Please contact NorthClark Computing, Inc. if you need assistance with this setup procedure. 

 

Your custom fields will appear as columns on the main spreadsheets used for Bill of Material and Part 
Number entry.  They are also displayed on the Item Detail Display of Bill of Material Maintenance and 
the Engineering Display of Parts Master Update.  Please see the BOM Maintenance Help File for more 
information. 

You may also use the Custom Fields screen to modify the attributes of standard Manfact fields including 
the prompt name and field length.  Additionally, you may define a list of valid entries that will be 
presented to the user as a drop-down list during data entry. 

Click the OK Button to save changes. 
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Custom Fields Definitions And Instructions: 

Field Definition 

File and Association Use the drop-down list to select the file and association for the field 
you wish to add. 

Field Number Enter the physical location in the file where data is stored.  Be sure to 
refer to the file dictionary for this information – it is NOT the same as 
the prompt numbers displayed in Manfact data entry screens. 

Prompt The system will read the Manfact dictionary for the specified file and 
field number, and display the description.  This will be the prompt the 
user sees during data entry.  You may change it if desired. 

Data Type Set the data type for this from the drop-down list: 

Number:  This option will require numeric input. 
Text:  Allows all alphanumeric characters. 
Date:  Requires the user to enter a valid date. 
Checkbox:  User is presented with a graphical checkbox for simple 

yes/no entries.  Data is stored in Manfact as “Y” or “N” only. 
Notes:  Free-form unlimited lines of text with word-wrapping. 

Values Select Single for items with one-line entries or Multiple for items that 
will use a Pop-up Spread for multi-line entries from the drop-down list. 

Min Length The minimum amount of data that may be entered by the user.  

Max Length The maximum allowable length of characters that may be entered. 

Number Decimals Number of decimal places allowed for numeric entries. 

Valid Entries Double-click on this cell to enter a list of allowable entries and 
associated descriptions for these fields in the pop-up window.  These 
values will be presented to the user as a drop-down list. 

Valid Descriptions Valid Descriptions are entered as part of the pop-up window when 
Valid Entries are entered. 
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Miscellaneous Display 

Use the Miscellaneous tab to apply the following rules to the entire Bill of Material Maintenance and 
Parts Master Update Module: 

 

� Enable Bill of Material File Security Checking (BOM, ENGBOM, WOBOM). 

When this option is selected, access to each of the Bill of Material files will be permitted only 
when the user has access to the corresponding Manfact entry screen:  BOM.N, ENGBOM.N, and 
WOBOM.N.  For example, if a particular user is authorized to use ENGBOM.N but not BOM.N, 
they will be able to save changes to the engineering database, but they will not be allowed to 
update the Production Bill of Material file. 

If this option is not enabled, all users with access to Ncc_BomEntry are allowed to update all Bill 
of Material files, regardless of their other Manfact privileges. 

Note:  Access rights are granted using the Manfact Security System in your MRPISYS account.  
Users must be granted rights to Ncc_BomEntry in order to access the program, regardless of the 
option chosen here. 

� Enable Parts Master Departmental Security Checking. 

The Parts Master Entry procedures in the Manfact system are organized into four departments:  

• Engineering (PARTS.EN) 
• Material Control (PARTS.MC) 
• Marketing (PARTS.MK) 
• Purchasing (PARTS.PC) 

A fifth screen, PARTS.ALL, is available for users who are authorized to update all fields in the 
Parts file. 
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When you select the option to Enable Parts Master Departmental Security Checking, the system 
will check the user’s Manfact security settings to determine which fields may be updated using 
the Ncc_BomEntry procedure.  The user would be required to have access to PARTS.EN in 
order to update engineering data, PARTS.MC for material control information, and so forth.  
Users with access to PARTS.ALL may update all fields. 

If this option is not enabled, all users with access to Ncc_BomEntry are allowed to update all 
Part Master fields regardless of their other Manfact privileges. 

Note, access rights are granted using the Manfact Security System in your MRPISYS account.  
Users must be granted rights to Ncc_BomEntry in order to access the program, regardless of the 
option chosen here. 

� Require All Part Numbers to be in Upper Case: 

When this option is selected, all entries at Part Number prompts will be automatically converted 
to capital letters.  

� Allow WOBOM and PICKER to be updated for released Work Orders. 

The Bill of Material Maintenance application may be used to update material requirements for 
existing work orders.  While this capability is always enabled for new jobs, you may choose to 
enable or disable this feature for released work orders. 

� When a PICKER is updated, execute WO07 using these batch instructions: 

This option is only active if you have enabled Bill of Material updates for released work orders.  
If your company uses the Manfact Work Order Reservation system, it will be necessary to update 
backorders and reservations when the picker record is changed.  The system performs this update 
for you automatically by executing Manfact’s WO07 procedure.  WO07 requires that a set of 
instructions be defined using the TABLE.AMXWO.BATCH entry procedure in your Manfact 
system.  Please refer to the Manfact system documentation for more information about the use 
and setup of these procedures. 

Enter the name of the instruction set you wish to use at this prompt.  If your company does not 
use work order reservations, or you not wish this update to be performed, simply leave this 
prompt blank. 

� Click the OK Button to save changes. 
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Installation and Security Tips 
This topic contains technical information that may be useful to programmers and system administrators. 

For ease of installation, it is recommended that the program be run for the first time by someone who 
has system administrator privileges on the server, and has a Manfact security level of “5”.  This person 
should have the authority to compile programs, create files and edit VOC entries.  This will allow the 
application to automatically create or install the necessary supporting files and software components.   

Security Requirements 

Access to NorthClark applications is governed by the Manfact security system.  The System 
Administrator must add the appropriate commands to each user’s security table.  Please refer to the 
Manfact documentation for more information on setting up security tables. 

The following NorthClark procedures must be added to the Manfact security tables: 

Routine Description 

NCC_BOMSETUP Allows access to the NorthClark Bill of Material Setup program. 

NCC_BOMENTRY Allows access to the NorthClark Bill of Material Entry program. 

Once a user has been given access to NCC_BOMENTRY, their privileges within the application may be 
limited according to Manfact security settings for Bill of Material and Part data access.  The following 
Manfact security table entries may affect the behavior of NCC_BOMENTRY: 

Routine Description 

BOM.N User may update the Production Bill of Material file. 

ENGBOM.N User may update the Engineering Bill of Material file. 

WOBOM.N User may update the Work Order Bill of Material file. 

PARTS.ALL Allows access to the same data a user would have using PARTS.ALL 

PARTS.EN Allows access to the same data a user would have using PARTS.EN 

PARTS.MC Allows access to the same data a user would have using PARTS.MC 

PARTS.MK Allows access to the same data a user would have using PARTS.MK 

PARTS.PC Allows access to the same data a user would have using PARTS.PC 

ENGPARTS.N Allows access to the same data a user would have using ENGPARTS.N 
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VOC Entries 

The first time the program is executed, a VOC entry is automatically created in the Manfact account.  
This record must be present before updating security tables.  If the user’s security privileges do not 
permit this, the System Administrator may create it manually: 

 
ED VOC NCC_BOMENTRY 

0001: S 

0002: RUN NCCVB NCC_BOMENTRY 

 

NorthClark Files 

The following files will be created by this application if they do not already exist in your Manfact 
account: 

File Purpose 

NCC_BOM Work file used by the Bill of Material explosion process. 

NCC_PARTSW Work file used to manage changes to Parts records. 

NCC_PARTSA Audit file used to record before/after changes to Parts records. 
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General Information 

Printing a Spreadsheet 

To print the current active spreadsheet, select the Print option from the File menu.   

 

Range 
You may choose to print All (the entire spreadsheet), Selected Cells (those that you have highlighted 
on the current screen), Current Page (only the rows that are currently visible on your screen), or 
Pages (any range of page numbers).  

Orientation 
You may print your report in portrait mode (normal) or landscape mode (sideways).  Printing in 
landscape mode will allow you to fit more columns of information on your report.  

Margins 
You can make your report more attractive by setting the top, bottom, left, and right margins.  Reduce 
the left and right margins to fit more columns on the report.  

Units 
Select inches or centimeters to designate the unit of measure for the entered margins. 
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Page Order  
If your report is too wide to fit on a single page, it may span multiple pages.  When this occurs, select 
your preference to have the report printed from top to bottom or left to right.  

Print 
You can customize the appearance of your report by printing (or not printing) column headers, row 
headers, grid lines, borders, shadow, and color.  

Headers and Footers  
Your report may have up to three lines for the heading, and one line for the footer.  The system 
initially displays a default heading, which you may modify if desired. 

Tip: Use /p to designate a page number.  

Columns to Print  
The columns that are available for printing are listed.  Select the columns you wish to include on your 
report.  

Importing Data    

To import a Bill of Material from Excel, see Importing a Bill of Material.  Data other than a Bill of 
Material may be imported from a Microsoft Excel spreadsheet, a tab-delimited text file, or a comma-
separated text file.  Open the desired spreadsheet which is to receive the imported data via the File 
Search button. 
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Import File Name  
Enter the path for the file that you wish to import.  You may browse the files by clicking on the 
button next to the text box. 

Header Rows

Enter the number of rows at the beginning of the file that are not to be imported. 

Import File Type
Select the type of file that you are importing. 

Data Mapping
Enter the Column Number or Letter where data resides on the Excel file.  Use the Reset button to 
restore the fields to their original state.  Use the Clear button to clear all fields.  Use the Auto 
Number button to automatically number the values sequentially. 

Import Data
Click the OK button to begin the import procedure. 

 

Exporting a Bill of Material Spreadsheet 

From the spreadsheet you wish to export select Export from the File menu in the Bill of Material 
Maintenance module.   

 

Map Name 
Select the name of the import/export map you wish to use from the drop-down list. 
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Excel Template 
As an option an Excel template may be selected to add headings, borders and other graphics to your 
report. 

Excel File Name to Create 
Enter the Excel Sheet Name to create. This will automatically default to Sheet1. 

Spreadsheet Format 
You Excel workbook may contain multiple sheets.  The first (Master) sheet is usually a single-level 
bill for the top assembly.  If you have a multi-level bill, a separate sheet will be generated for each 
sub-assembly contain herein.  Select the sheet(s) you wish to produce using the radio buttons on this 
screen. 

Maximum Level to Include on Master Sheet 
Enter the number of levels to explode for the Master sheet.  Enter ‘1’ for a single-level bill. 

Export Expired Rows

Check the Export Expired Rows button to export expired rows.  Leave it blank to not export expired 
rows. 

Export Button 
After all required information has been entered, click the Export button to export your data to 
Microsoft Excel. 
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Exporting All Other Spreadsheets 

You may export the contents of displays, such as Parts Master Maintenance, directly to Excel, or you 
may choose to create a file in Excel format.  The format of the Excel file will match the layout of the 
spreadsheet on your screen. 

 

Save As File Name 
Enter the pathname of the file you wish to create. 

Save As Sheet Name 
Enter the Excel Sheet Name to create.  This field will automatically default to Sheet1. 

Export Directly to Excel 

This is the easiest way to export data.  If Excel is not already running on your computer, the system will 
attempt to start it.  The information from the display is then loaded directly into corresponding cells in 
the Excel spreadsheet. This option may be used with either Microsoft Excel 95 or Excel 97. 

Export to File in Excel Format 
This option allows you to create a file in Microsoft Excel 97 format (BIFF8). This option may be 
preferable when exporting large amounts of data.   

Create a Log File 

Select this option to create a log file.  The log file contains error messages and other information about 
how your Excel file was created. The name of the log file will be “CreateExcelFile.log”, and it will be 
stored in the same folder as the spreadsheet. 
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Data Mapping 
Data Mapping allows you to change the sequence in which the data will be stored.  Use the Reset button 
to restore the fields to their original state.  Use the Clear button to clear all fields.  Use the Auto 
Number button to automatically number the values sequentially. 

Export Button 
After all required information has been entered click the Export button to export your data to Microsoft 
Excel. 

Editing Features 

Copy, Cut, Paste and Fill 

You may use the standard Windows Copy, Cut, and Paste features to copy or cut data to the Windows 
clipboard, or to paste data from the clipboard into a cell.  

To copy data, hold down the left mouse button and highlight one or more cells.  Choose one of the 
following methods to copy the highlighted cells to the clipboard:  

1.  From the Edit menu choose Copy. 

2.  Click the Right Mouse button, and choose Copy from the drop-down list.  

3.  Click the copy icon (two overlapping sheets of paper) on the toolbar.  

4.  Hold down the Ctrl key and type the letter C (Ctrl-C). 

The above methods can be used to Cut (Ctrl-X/Scissors icon) and Paste (Ctrl-V/Clipboard with paper 
icon).  

To copy and/or cut the contents of an entire row, click once on the row header (the number displayed on 
the left side of the first cell), then choose Copy and/or Cut.  Click on the row header that you want to 
copy the data to and choose Paste. 

To update several cells with the same value, highlight all of the cells you wish to update then select Fill 
from the Edit Menu or from the right click menu.  This command will update each cell with the current 
information from the clipboard. 

Zoom 

This feature allows you to view, print and/or edit the expanded contents of a field.  It is especially useful 
for multi-line information such as notes and long descriptions. 

• Zoom in on any selected item by selecting Zoom from the Edit Menu, clicking the magnifying 
glass on the toolbar, or selecting Zoom from the right click menu.   
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• The Column Name will appear in the Title Bar with Edit (an editable field) or View (a view only 
field).  Make any entries or changes desired and click the OK button when finished, or the 
Cancel button to revert to the original data.  

• Locked fields may be viewed but not modified using the Zoom Feature.  If the field is locked, 
View will appear in the Title Bar, and there will only be a single command button labeled Done. 

• To print the selected item, click on the printer icon and the information will be sent to your local 
printer. 

Customizing Your Display / Arranging Columns 

Select Display Options from the View Menu to customize the display.  

 

� Each tab contains a list of fields that corresponds to a screen used in this application.  Click the 
checkboxes to show (a checkmark in the box) or hide (a blank value in the box) each field 

� Use the Move Up and Move Down Buttons to re-arrange the order in which the fields appear on 
the specific screen Display.  Click Reset All to return to the system’s default settings. 

� To select the color for highlighting rows that have been modified, during data entry, but not 
saved, click the Select Color for Changed Rows button.   

� You may opt for the system to Remember Screen Size and Column Widths. Any changes you 
make to the screen's appearance will be saved and applied the next time you launch this 
application.  
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� On the BOM Screen you may choose the option to Indent Part Number by Level. 

� Choose the number of columns (from left to right) you wish to freeze on the spreadsheet. A 
frozen column will remain in place as you scroll to the right.  

� Click the OK button to apply any changes you have made or the Cancel button to revert to the 
previous settings. 

Note:  These settings are stored in the Windows Registry for each user. 

Wildcarding 

Wildcarding is a powerful feature that allows you to search using a portion of the field.  You tell the 
system you want to use a wildcard by typing three periods “…” or an asterisk “*” at the beginning or 
end of your search entry.  See the table below for examples of wildcard commands and their expected 
results. 

Item Sample Description 

Part Number  XTR…  or XTR* Returns part numbers that begin with “XTR”  

Description …VALVE… or 
*VALVE*  

Returns parts with the word “VALVE” anywhere in the 
description.  

Category …A or *A  Returns parts with a category ending with the letter “A”. 
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